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Overview

Over the past few years, the Air Force has made tremendous progress in developing multimedia training programs, computer-based instruction, paperless career development courses (CDCs), and now computer-based tests.

CerTest is an Air Force-owned, interactive, computer-based testing program designed to test, evaluate, and certify a student's knowledge of the principles and procedures found in today’s Air Force specialties.

This document has been created to help Test Control Officers effectively execute their responsibilities administering computer-based tests.  Please read this entire document before loading the CerTest computer-based testing program.  If you have any questions, problems, or are in need of assistance, please do not hesitate to call the program POCs, listed below.  

AFIADL Computer-Based Testing POC Information

Technology Division

(CerTest Policy Issues and New Computer-Based Testing Customers)

Mr. Steve McCarver

DSN:  596-3174

Steve.McCarver@maxwell.af.mil


Student Administration

(CerTest Installation Problems and Error Messages)

Ms. Wilma Price

DSN:  596-4775

Wilma.Price@maxwell.af.mil 

Ms Deloris Williams

DSN:  596-4775

Deloris.Williams@maxwell.af.mil
Data Branch

(Provides customer assistance with Downloading CerTest Data Files, the Answer Sheet Manager Program, and transferring files using the File Transfer Program (FTP) software)

Ms Geraldine Maull

DSN:  596-4640/4628

Geri.Maull@maxwell.af.mil

Ms Katrina Boren

DSN:  596-4628/4640

Katrina.Boren@maxwell.af.mil
Ms Sylvia Bloomquist

DSN:  596-4628/4640

Sylvia.Bloomquist@maxwell.af.mil
AFIADL Web Master

(Downloading New or Revised Tests, Disabled Questions, and CerTest Program Updates)

Ms. Evelyn Milton

DSN:  596-4620

Evelyn.Milton@maxwell.af.mil


The Fear of Moving to Computer-Based Testing

According to John Yopp, Vice President for Graduate and Professional Education at ETS, “It is important to keep in mind that changes of this magnitude--in any field--are usually accompanied by anxiety and “fear of the unknown.”  Research in computer-based testing indicates that once individuals have taken a computer-based test, they become more comfortable with the new testing environment and find that the benefits associated with the test offset those aspects of the test that are new and unfamiliar.”

History of Computer-Based Testing

Computer-based testing is used in industry by organizations that offer testing for academic admission and organizations that administer certification or licensing programs for professionals.  Organizations using computer-based testing include Microsoft Corporation, Novell, Lotus, the Federal Aviation Administration, and numerous professions such as accountants, pilots, financial planners, medical examiners, and clinical pathologists.

Within the academic sector, the Educational Testing Service (ETS) administers all major entrance exams.  Below is some information about ETS’s move to computer-based testing.

- In 1993, the first test administered using a computer was the Graduate Record Exam (GRE), which is a standardized entrance test used by most graduate schools to measure academic knowledge and skills.  During the initial phase-in, students had the option to take the GRE on computer or on paper.  By the fall of 1999 the GRE General Test was offered only on computer in both the U.S. and abroad.  The last scheduled paper-based GRE test was in April 1999.

- In 1998, approximately 365,000 people took the GRE General Test.  All computer-based tests are administered at testing centers (Sylvan Learning Centers) located throughout the country.

- All test questions are currently multiple choice, but they plan to add other question types, such as short answer and fill-in-the-blank questions, that can be used to test manipulative skills.  Essay questions will also be added but will still need to be scored manually.

- Since October 1997, the GMAT (Graduate Management Admission Test), used by business schools as entrance criteria, has moved to a computer-based format.  From June 1995 to May 1998, 602,037 people took this exam.

- A computerized version-reasoning test is available to support the Center for Talented Youth (CTY).  CTY is a talent search program at Johns Hopkins University.

- A program to migrate the Test of English as a Foreign Language (TOEFL) began in 1993.  From the spring of 1997 through the spring of 1998, pretesting was conducted and studied.  The TOEFL exam was introduced in a computerized format in July 1998.  Most countries now offer only the computer version of the test.

Below are some examples of certification and licensing exams offered on computers.

The Federal Aviation Administration (FAA) offers a number of computer-based tests.  Most recently, it has committed to moving their Basic Electronics Screening Tool (BEST) to the computer.  This test is part of the pre-employment screening process for potential candidates at the FAA’s Airway Facilities.

The United States Medical Licensing Examination (USMLE) began its transition to a computer-based format in May 1999.  This exam is required for most physicians to become licensed in the United States.  USMLE results are reported to medical licensing authorities for determination in granting initial licenses to practice medicine and providing assurance of high quality, valid, and reliable assessment.

The American Registry of Radiologic Technologists (ARRT) began offering its mammography test on the computer in January 1999.  The ARRT mission is to recognize individuals qualified in the safe and effective application of radiologic technology.  Beginning in January 2000 seven additional exams will be offered via computer.  The seven certification areas are: cardiovascular-interventional technology, computed tomography, magnetic resonance imaging radiography, nuclear medicine technology, radiation therapy technology, and quality management.

Other tests currently being offered on the computer include the PRAXIS SERIES:  Professional Assessments for Beginning Teachers, the National Board for Professional Teaching Standards (NBPTS) assessments, the registered and practical nurses licensing examinations (NCLEX), the National Association of Securities Dealers (NASD) exams, and the National Counsel of Architects Review Board (NCARB) tests.

The College for Enlisted Professional Military Education (CEPME) at Gunter AFB AL began offering computer-based formative and summative exams for the Senior Noncommissioned Officer distance-learning course in October 1996.  These (case study) scenario-based exams utilize weighted scoring to evaluate students at the application level in the areas of Leadership and Planning, Behavioral Analysis, Human Resource Development, Organizational Management, and Communication Skills.  The final course score (80% = passing) is derived from averaging the scores of the five tests.  Approximately 45,000 exams were administered between FY97 and FY99 with an exam failure rate of only 2.24%.  Successful students are summarily awarded 9 junior college credit hours in leadership and management through the Community College of the Air Force.

CerTest Background Information
The civil engineering community first began using CerTest in 1992.  Its initial use was to support transition training as they began multi-skilling their workforce and for supplemental self-study.

In May 1993, the Environmental Protection Agency (EPA) issued regulations on handling ozone depleting chemicals and a requirement for people who maintain, service, or repair refrigeration and air conditioning systems containing hydrofluorocarbons (CFCs) or hydrochlorofluoro-carbons (HCFCs) to be certified by an approved certification program.  This certification had to meet EPA guidelines and be obtained prior to 14 November 1994.  After making a few software modifications to track EPA-specific criteria, the EPA approved the use of CerTest to achieve this certification.  This new process saved DoD $7.3 and was better, faster, and cheaper than sending people TDY to school or purchasing contractor-provided training.

The fire protection community adopted CerTest and made its first distribution in October 1994.  CerTest is now an integral part of the DoD Fire Fighter Certification Program which has been accredited by the International Fire Service Accreditation Congress operated by Oklahoma State University.  Additionally, computer-based testing has been incorporated into all Goodfellow AFB Joint Fire Protection Training School courses where students are required to take their required block tests on a computer.

In February 1996, CerTest moved from a DOS-based program to the WindowsTM environment.  This migration included many software enhancements, which now make CerTest even better suited for use as a testing tool for the Air Force Institute of Advanced Distributed Learning (AFIADL, formerly ECI) final exams.

From 1 Aug 96 through 1 Jan 97, AFIADL and Headquarters Air Force Civil Engineer Support Agency (HQ AFCESA) tested this capability by taking advantage of existing AFIADL policies and procedures.  The only major difference was administering the end-of-course exam using a computer and the procedures we’ve specifically added to address that aspect of the test.

Two control groups were developed to test this capability.  The bases and commands listed below were selected to participate in this initiative for the following reasons.  Group #1 represented bases that HQ AFCESA personnel could comfortably drive to in less than four hours to provide hands-on CerTest training, if necessary, to test control officers and fire fighters to make sure they fully understood how to use the program.  Group #2 did not receive hands-on training and had to rely on the instructions written in this plan or call for assistance.


Group #1






Group #2
1.  Tyndall AFB, FL  (AETC)



1.  RAF Mildenhall AB, England  (USAFE)

2.  Hurlburt Field, FL  (AFSOC)


2.  Kadena AB, Japan  (PACAF)

3.  Maxwell AFB, AL  (AETC)


3.  March ARB, CA  (AFRC)

4.  Duke Field, FL  (AFRC)



4.  Grand Forks AFB, ND  (ACC)

5.  187th Montgomery, AL  (ANG)


5.  Hanscom AFB, MA  (AFMC)

6.  Eglin AFB, FL (AFMC)

During the beta test, 119 students from eight Air Force Major Commands voluntarily participated in this initiative by taking the nine course exams shown below using the CerTest computer-based testing program.

	Volunteers
	Computer-Based Test Taken

	18 Students
	47202 – Hazardous Materials Operations

	35 Students
	3E751A – Fire Fighter II

	2 Students
	57150A – Fire Fighter II

	9 Students
	57150B – Driver Operator Pumper

	1 Student
	57150C – Driver Operator Aerial

	9 Students
	57150D – Driver Operator ARFF

	12 Students
	57150E – Airport Fire Fighter

	18 Students
	57170A – Fire Officer I

	15 Students
	57170B – Fire Instructor I


Of the 119 student volunteers, 86 were completing 5-skill level courses, 30 were completing 7-skill level courses, and 3 were civilian employees completing Fire Fighter Certification Program courses.

Of these, 93.3% (111 students) passed the test the first time, 5% (6 students) passed on their second attempt, and 1.7% (2 students) had a two-time failure rate.

At the conclusion of the beta test, we requested and received feedback from each of the students and the test control officers who voluntarily participated in this initiative.  The feedback received was unanimously positive and has served as the foundation for implementing computer-based testing Air Force-wide starting with the 13 Civil Engineer Career Fields.  The ultimate plan is to allow other career fields/professions the opportunity to offer their customers the computer-based testing option once AFIADL feels comfortable with the new computer-based testing protocols and procedures.

Benefits

As you can see, there are several organizations successfully using computer-based testing.  In today’s society, taking advantage of computer technology has quickly become the routine way to do business.  Many of our Air Force installations now have local area networks, web sites, home pages, e-mail capability, and the ability to retrieve information from the Internet.  Computer-based testing appears to be the wave of the future and is also the next logical step for the Air Force to take to further enhance its education and training programs. 

The benefits of the CerTest computer-based testing program include:

· Immediate student scoring and feedback.

· Increased efficiency (minimizes the need to produce paper-based tests).

· Ease of updating and distributing.

· Built in security.

· Test bank and test item randomization.

· Built in test item analysis for question validity and reliability.  (Including discrimination index data)

· The ability to ask seven different question types (graphic identification, true/false, fill-in-the-blank, matching, multiple choice, sequencing, and multiple/multiple choice).

· Electronically disable bad test bank questions.

Roles and Responsibilities
HQ USAF/DPPE:  Provides functional oversight and program direction as the OPR for all Air Force Education and Training Programs.

AFIADL:  Serves as the program OPR, distributes CerTest, distributes tests, and publishes disabled question information.  Provides Test Control Officer support as required. 

Test Control Officers (TCO):  Completely read and implement the procedures contained in this guide.  Load the CerTest program on the appropriate computer hard drive(s).  Become familiar with the use of CerTest by taking the tutorial and short demonstration test (Test Number 9000).  Administer and proctor applicable CerTest exams.   Ensure the student reads and signs the “Special Instructions to Computer-Based Testing Students.”  Electronically send student test data files to AFIADL using the Answer Sheet Manager Program and the File Transfer Program software.  Disable questions as required and download new or revised tests quarterly from the AFIADL Web Site at http://www.maxwell.af.mil/au/afiadl/operations/certest.htm 

Students:  Study and prepare for the CDC end-of-course exam.  Read and sign the “Special Instructions to Computer-Based Testing Students” form before the test session begins.  Students must be prepared to sit through a test until it is completed.

General Information and Requirements

Users Guide Information:  All program documentation and help for the WindowsTM version of CerTest is on-line.  If you’re not sure how to do something, simply use the Help pull-down menu in CerTest to receive information or instructions on the topic you need help with.  In addition, the more common tasks you are required to perform have been included in the Appendices section of this guide.

Program Management:  CerTest may be installed on more than one computer, however, computers loaded with CerTest must be located so their use can be controlled by a TCO.  The loading instructions are located on page 21 of this document and on the CerTest CD-ROM as a readme.txt document.

Question Randomization:  Each test within CerTest has a bank of questions from which the final exam is drawn.  For example, test 9003 (Firefighter II) has 209 questions in the test bank, but only 115 questions appear on the final exam.  Additionally, the questions also randomize when they appear on the computer screen.  For example, you might have two computers that have the same question come up at the same time, but the correct answer on Computer #1 is “a” and the correct answer on Computer #2 is “d.”  This is a built-in security feature designed to minimize the potential for a test compromise.
Bookmark Feature:  CerTest has a bookmark feature that a student may find very useful. When taking a test, the student can choose to bookmark a question and return to it later before the test is exited and scored.  For further information concerning bookmarking a question, see “How to Bookmark a Question” on page 30.

Moving Within a Test Using the Scroll Bar:  Another helpful feature for the student is the scroll bar located in the bottom right-hand corner of the test screen when a student is actively taking a test.  This feature allows the student to move forward or backward one or more questions at a time.  For example, let’s say a student is completing a 60-question test but they’d like to review questions 5, 12, 39, and 52 before they exit and score the test.  In this instance, the student could quickly review these questions by using the scrolling bar or the bookmark feature.  For further information on moving within a test, see “Moving Within a Test” on page 31.

CerTest Spell Checker: CerTest has a powerful spell checker.  However, this feature is not applicable for the AFIADL version of CerTest because we are not using fill-in-the-blank questions at this time.
Program Errors:  If a program error occurs, write down the information exactly as it appears on the computer screen, and then contact the AFIADL Student Administration Branch by e-mailing the error information to eiic@maxwell.af.mil.  If possible, before you report the problem, please see if you can duplicate the error and capture the sequence of keystrokes you or the student made when the error occurred.  Additionally, please include your commercial phone number in the e-mail message because the CerTest programmer does not have DSN access.

Test Control Facilities:  The space and physical facilities selected for computer-based testing must be conducive to continuous surveillance by a TCO.  The TCO must ensure conditions are favorable for testing such as proper lighting, temperature, and freedom from distractions.  A centralized testing facility is recommended for controlling the CerTest program.  The TCO must be able to monitor all computers at one time while official CDC testing is in progress.

Computer Hardware:  To avoid potential problems with students accidentally kicking power supply cords or turning off the CPU button, please position the CPU and all power supply cords so they are not accessible to the student.

Statistical Data:  Each time an exam is taken in CerTest, the program automatically collects data, which is used to validate the test.  These data files contain the following data:

· Student’s test results

· Each student’s electronic answer sheet

· Cumulative statistical data about the tests taken

· Any question challenges 

Testing Policies and Procedures

Students:  A student must be prepared to sit through a test until the test is completed.

Time Limits:  As with the paper-based test, the test session will not exceed three hours.

CerTest Tutorial:  CerTest has a built in tutorial.  Most students taking computer-based tests will be familiar with the use of CerTest and will probably not elect to take the CerTest tutorial.  If a student decides to take the CerTest tutorial, the time used to take the tutorial should not be counted as part of the three-hour time limit.
Challenging a Question:  CerTest has an on-line question challenge form.  While taking a test, a student may find a question that he/she believes to be erroneous or invalid for some reason (i.e. typo, spelling mistake, missing graphic, ambiguous question, etc.).  The student may challenge the question by clicking on the hand icon located in the top right-hand corner of the toolbar, or by selecting “Challenge this Question” from the Help menu.  If a student has a concern about the accuracy or clarity of a question, they must challenge the question during the test session and the student’s comments must be as detailed as possible.  Warning:  No copy of the test question will be made by the examinee nor should one be kept on file.  All question challenges are automatically sent to AFIADL when you FTP the required student data files.  The information collected is equal to the student filling out an ECI Form 17.  For further information see page 32.

Test Interruptions

Ideally, once a student logs on to the computer to take a test, his or her session should be uninterrupted.  However, there are times when disruptions occur.  For example, in the event of a fire alarm or other emergency, the TCO and student should follow the appropriate emergency response procedures.

In the event of a power outage, the student (without penalty) will be allowed to retake the same test as soon as possible.  It is preferable for the test to be re-administered as soon as the power comes back on.  However, if time does not permit, a new test session should be scheduled.

Should a computer error prevent a student from completing a test, or a test from being scored, document the error and steps leading to the error and then (without penalty) allow the student to retake the test.

Students will not be penalized for events beyond their control.  Should a test session be interrupted, the TCO will print the student’s test summary and document the circumstances that caused the interruption and notify AFIADL Data Branch representatives.

Score Button:  At the end of the test, a score button and message will appear.  The following message will appear and the procedures specified in this message must be followed.

“To score this test, the test control officer must input their password.  If you are ready to exit and score your test, call the test control officer over to your computer now.  Press Cancel to continue reviewing your test.”

If for some reason you leave any questions unanswered, the following message will appear.

“You have left XX questions unanswered.  Select OK to exit this test anyway (your unanswered questions will be counted as wrong); or select Cancel to continue working on this test.”

Bookmarked Questions:  If the student has bookmarked a question the following message will appear.

“You have a bookmarked question.  Select OK to exit this test anyway; or select Cancel to continue working on this test.”

Passing Score:  The passing score for all AFIADL CerTest computer-based exams is 65 percent.
Test Failures:  If a student fails the test, provide the student with a hard copy of the "Test Summary" (this shows the learning objective(s) that require further study).  Anyone failing a test should restudy before taking the test a second time.  See Attachment 2 for further details.  The “Test Summary” form is set up very similar to an ECI Form 9.

Record Keeping:  When the student completes the required knowledge test, print one copy of the “test summary” and provide it to the student.  If a copy of the test summary is required at a later date, it can be recalled by entering into the Student Record and selecting the “Detail” option under the “View menu” or by double clicking on the Stat, Score, Date, or Attempts block for that particular test.

Procedures on how to print these documents and samples are shown in Attachments 2 and 3.

The Process

1.  A student enrolls in an AFIADL course and studies the required training material.

2.  When the student is ready, the course exam (CE) must be ordered from AFIADL.  If you already have the CerTest program on hand, then you only have to make sure you have the most current course exams/disabled questions by visiting the AFIADL Web Site at http://www.maxwell.af.mil/au/afiadl/operations/certest.htm.

3.  Once received, the Test Control Facility (TCF) notifies the student (using existing procedures) that the CE has arrived on base and schedules him/her to take the test. 

4.  The student reports to TCF for scheduled testing.

5.  The TCO adds the student to the CerTest program and also unlocks the applicable CE.  (See pages 28 and 29 of this plan).

Note:  When you add a new student, use a password that is easy for you to remember (i.e. the letter “a” or the student’s first and last initial).  Any password you choose to use to simplify the process is acceptable.  

6.  Have the student read and sign the Special Instructions to Computer-Based Testing Students found at Attachment 5.

7.  The student logs-on to the computer using their actual social security number and the password you’ve provided.

8.  The student takes the applicable test.  When the student answers the last question, he/she will be asked if they want to exit and score the test.  Before exiting and scoring the test, the student will call the TCO over to the computer so the TCO can enter their validation code so the test can be exited and scored.  The test control officer must directly observe the test being scored.

9.  The TCO will print and provide one copy of the “Test Summary” to the student.  (See Attachment 2)

10.  If the student fails the CE, the “Test Summary” will show the learning objective(s) that require further study (See Attachment 2).  Anyone failing a final exam will be afforded the opportunity to restudy before taking the final exam a second time.  The TCO must schedule the student for the retake within 30 days.

11.  Send the test results to AFIADL.  (See page 39 for specific instructions)

CerTest Question Types

Multiple Choice Question:  A multiple choice question allows the student to answer a question by making a choice of three or four available answer choices.  A multiple-choice question has only one correct answer.  This type of question keeps guessing to a minimum.

Graphic Identification Question:  A graphic identification question asks the student to identify an “object” or “objects” shown on a displayed graphic image.  To respond to a graphic identification question, the student clicks on the correct location on the displayed image or drags the pool ball to the correct location on the graphic.

Matching Question or Matching with Graphic Question:  A matching question has two lists of related words or symbols.  The items in the first list are matched with their associated items in the second list.  A matching with a graphic question requires the student to match the item name with the item image in the graphic.

Sequencing Question:  A sequencing question has a list of events or steps that the student must put in some sort or order.

Multiple Choice/Multiple Correct Question:  A multiple choice/multiple correct question has the format of a multiple-choice question (stem with up to eight answer choices).  The only difference between the simple multiple-choice question and this type is that the first allows only one correct answer and the other allows more than one correct answer.

Scenario with Question:  Each of the questions types explained above may include a scenario.  When a scenario is needed for a question it is placed on a separate page or pages.
*Fill-in-the-Blank Question:  A fill-in-the-blank question is a statement that has one or more words missing.  The student has to correctly complete the statement by inputting the missing word(s) or number(s).

*True/False Question:  A true/false question makes a statement and asks the student to agree/disagree with it.  A word of caution:  this type of question gives the student a 50-50 chance of guessing the correct answer.

* Note:  Fill-in-the-Blank and True/False questions are available in CerTest but ARE NOT currently being used in AFIADL CDC exams.

Attachment 1

Test Summary Information

To maintain test security, CerTest does not provide specific test question feedback.  However, just like existing CDC exams, CerTest does indicate the Learning Objective(s) (LO) that require further study.  The following “Test Summary” information is designed to help students pinpoint the areas that require further study.

Here's how you would use the following printout:  Let's say a student missed questions in Sections 2 and 3 of the HazMat Awareness test shown below.  To pinpoint the areas requiring further study, you'd refer to the HazMat Awareness Level CDC course LO 002 (Definitions of Hazardous Materials) and LO 003 (Classes and Divisions).  The questions column tells the student how many questions appeared on the test and the correct column tells the student how many questions they answered correctly in each particular section.

Sample Test Summary
Carruthers, Joe
     125-65-5768
9020 – Hazardous Materials Awareness

Test Date:
28 Jan 00
Score:

91%
Criterion:
65%


REVIEW TRAINING        STARTED __________   DUE COMPLETION __________   COMPLETED __________


REQUIRED ____


NOT REQUIRED ____     __________________________________     _____________________________________

                                                  SUPERVISOR’S SIGNATURE                             TRAINEE’S SIGNATURE

Section




  Title



 
    Questions    Correct
	      1
	  LO 001 General
	       2
	       2

	      2
	  LO 002 Definitions of Hazardous Materials
	       3
	       2

	      3
	  LO 003 Classes & Divisions
	       25
	       20

	      4
	  LO 004 HazMat vs. Other Emergencies
	       1
	       1

	      5
	  LO 005 Occupancies & Locations
	       2
	       2

	      6
	  LO 006 Container Shapes
	       3
	       3

	      7
	  LO 007 Marking & Colors
	       3
	       3

	      8 
	  LO 008 NFPA 704
	       2
	       2

	      9
	  LO 009 Where to Find MSDSs
	       1
	       1

	    10
	  LO 010 MSDS & Shipping Paper Entries
	       5
	       5

	    11
	  LO 011 Shipping Papers
	       2
	       2

	    12 
	  LO 012 Locations of Shipping Papers
	       3
	       3

	    13
	  LO 013 Examples of Clues
	       2
	       2

	    14
	  LO 014 Limitations of Using Senses
	       2
	       2

	    15
	  LO 015 Criminal or Terrorist Targets
	       1
	       1

	    16
	  LO 016 Indicators of Criminal/Terrorist Activity
	       1
	       1

	    17
	  LO 017 Difficulties Determining Names
	       2
	       2

	    18
	  LO 018 Sources for Obtaining Names in Transport
	       2
	       2

	    19
	  LO 019 Sources for Obtaining Names in Facilities
	       1
	       1

	    20
	  LO 024 Basic Precautions
	       2
	       2

	    21
	  LO 025 Emergency Medical Care
	       1
	       1

	    22
	  LO 026 Typical Ignition Sources
	       1
	       1

	    23
	  LO 027 Harmful Effects of Hazardous Materials
	       1
	       1

	    24
	  LO 028 Routes of Entry
	       2
	       2










    
Totals:
70
       64
Attachment 2

Sample Student Record
MSgt Carruthers, Joe
     125-65-5768

Test



Title

 
                      Stat   Score        Date      Atmpts

	9001
	(CDC 3E731G) Firefighter I
	
	
	
	

	9003
	(CDC 3E751G) Firefighter II
	
	
	
	

	9005
	(CDC 3E751K) Airport Firefighter
	
	
	
	

	9010
	(CDC 3E751H) Driver Operator – Pumper
	
	
	
	

	9011
	(CDC 3E751J) Driver Operator – ARFF
	
	
	
	

	9012
	(CDC 3E751I) Driver Operator – Aerial
	
	
	
	

	9013
	(CDC 3E751L) Driver Operator – Tiller
	
	
	
	

	9020
	(CDC 47201G) Hazardous Materials Awareness
	P
	91
	28 Jan 00
	1

	9021
	(CDC 47202G) Hazardous Materials Operations
	
	
	
	

	9022
	(CDC 47203G) Hazardous Materials Technician
	
	
	
	

	9023
	(CDC 47205G) Hazardous Materials Incident Cmdr
	
	
	
	

	9030
	(CDC 57170G) Fire Officer I
	
	
	
	

	9031
	(CDC 57170K) Fire Officer II
	
	
	
	

	9032
	(CDC 10213G) Fire Officer III
	
	
	
	

	9033
	(CDC 10214G) Fire Officer IV
	
	
	
	

	9040
	(CDC 57170H) Fire Service Instructor I
	
	
	
	

	9041
	(CDC 10412G) Fire Service Instructor II
	
	
	
	

	9042
	(CDC 10413G) Fire Service Instructor III
	
	
	
	

	9050
	(CDC 10311G) Fire Inspector I
	
	
	
	

	9051
	(CDC 10312G) Fire Inspector II
	
	
	
	

	9052
	(CDC 10313G) Fire Inspector III
	
	
	
	


P = Passed
   F = Failed

For official use only.  This information is subject to the Privacy Act of 1974.
28 January 2000 
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Attachment 3
CerTest Checklist for Test Control Officers

· 1.  Log into CerTest as a program manager.

· 2.  Make sure you have the most current tests and that you’ve disabled any test bank questions (if applicable) by visiting the AFIADL Web Site at: http://www.maxwell.af.mil/au/afiadl/operations/certest.htm
· 3.  Add the student into the CerTest program (See How to Add a Student on page 28).

· 4.  Unlock the applicable Course Exam (See How to Lock and Unlock a Test on page 29).

This step is absolutely critical if the student is retaking an exam they failed previously.  To accurately collect the data that will ultimately be sent to AFIADL, the student must take the retake exam using the same computer used previously or you must copy the student’s record to a diskette and copy it into the new computer before the student takes the retake exam.  For help performing this task see How to Copy Student Information to/from a Diskette.

· 5. Print and have the student read and sign the Special Instructions to Computer-Based Testing Students found at Attachment 5.

· 6. Have the student log-on to the computer using their social security number and the password you provide.

· 7. The student takes the applicable exam.  Reminder:  When the student completes the exam, the test control officer must directly observe the test being scored by entering their exit password. 

· 8.  Print one copy of the test summary and provide it to the student (See Attachment 2).

Test Failures.  If the student fails the exam, schedule the student to retake the exam in accordance with AFIADL established policies and procedures.  The retake exam is already located in the CerTest program so you do not have to wait for the new exam to be sent to you.

· 9.  Copy the required student data files to a diskette, batch the files using the Answer Sheet Manager Program, and then send them to AFIADL using the File Transfer Program.  (See How to Gather and Send Student Test Results to AFIADL found on page 39 of this guide).


· 10.  File the Special Instructions to Computer-Based Testing Students form discussed earlier. 

Attachment 4

Special Instructions to Computer-Based Testing Students

Bookmark Feature:  CerTest has a bookmark feature that you may find very useful. When taking a test, you can choose to bookmark a question and return to it later before the test is exited and scored.

Moving Within a Test Using the Scroll Bar:  Another helpful feature is the scroll bar located in the bottom right-hand corner of the test screen when a student is actively taking a test.  This feature allows the student to move forward or backwards one or more questions at a time.  For example, let’s say you just completed a 60-question test but you would like to review questions 5, 12, 28, 39, and 52 before you exit and score the test.  In this instance, you could quickly review these questions by using the scroll bar or the bookmark feature.

Challenging a Question:  CerTest has an on-line question challenge form.  While taking a test, you may find a question you believe is erroneous or invalid for some reason (i.e. typo, spelling mistake, missing graphic, ambiguous question, etc.).  You may challenge the question by clicking on the hand icon located in the top right-hand corner of the toolbar, or by selecting “Challenge this Question” from the Help menu.  If you have a concern about the accuracy or clarity of a question, you must challenge the question during the test session and your comments must be as detailed as possible.  Warning:  No copy of the test question will be made by the examinee nor should one be kept on file.  All question challenges are automatically sent to AFIADL when the Test Control Officer FTPs the required data files.  The information collected is equal to the student filling out an ECI Form 17.

Score Button:  At the end of the test, a score button and message will appear.  The following message will appear and the procedures specified in this message must be followed.

“To score this test, the test control officer must input their password.  If you are ready to exit and score your test, call the test control officer over to your computer now.  Press Cancel to continue reviewing your test.”

If for some reason you leave any questions unanswered, the following message will appear:

“You have left XX questions unanswered.  Select OK to exit this test anyway (your unanswered questions will be counted as wrong); or select Cancel to continue working on this test.”

Attachment 5

If the student has bookmarked a question the following message will appear.

“You have a bookmarked question.  Select OK to exit this test anyway; or select Cancel to continue working on this test.”

Emergency Situations:  In the event of a fire alarm or other emergency, you must follow the appropriate emergency response procedures.  If this happens you will be given the opportunity to take the test again at the earliest possible date.
Power Outage:  In the event of a power outage, you will be allowed to retake the test as soon as possible.  It is preferable for the test to be re-administered as soon as the power comes back on.  However, if time does not permit, a new test session will be scheduled.

Computer Error:  Should a computer error prevent you from completing a test or a test from being scored, the Test Control Officer will document the error and steps leading to the error and allow you to retake the same test.

Students will not be penalized for events beyond their control.  Should a test session be interrupted, the test control officer will print the student’s test summary, document the circumstances that caused the interruption, and notify AFIADL Data Branch representatives.

Test Compromise.  Members of the ANG who are not otherwise subject to the UCMJ, by enrollment in this course, submit to the provisions of their respective state code of military justice and applicable Air Force sanctions for any violation of the paragraph below, or for any attempted or actual compromise of this examination.

Unauthorized discussion, disclosure, or possession of AFIADL course examinations is a violation of Article 92, UCMJ.  Members of the USAFR who are not subject to the UCMJ are subject to applicable disciplinary action according to AFI 36-701 and civilian penalties.

I certify that I have read and understand these instructions.

Signature:  __________________________________

Date:  ________________

Sample CerTest Question

This is a sample CerTest question.  We have highlighted several of the features that would be of interest to student’s taking the tests.  TCOs should become familiar with these features.
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Bookmark Feature:  When taking a test, a student may choose to mark a question and return to it later before the test is exited and scored.

Moving Within a Test Using the Scroll Bar:  The scroll bar located in the bottom right-hand corner of the screen is active during a test session.  This feature allows the student to move forward or backwards one or more questions at a time.  For example, let’s say you just completed a 60-question test but you would like to review questions 5, 12, 39, and 52 before you exit and score the test.  In this instance, you could quickly review these questions by using the scroll bar.

Challenging a Question:  While taking a test, a student may find a question that he/she believes to be erroneous or invalid for some reason.  The student may challenge the question by clicking on the hand icon located in the top right-hand corner of the toolbar, or by selecting “Challenge this Question” from the Help menu.

Attachment 6

Appendix A

How to Install CerTest

Introduction:  This is the Installation Guide for the Windows™ version of CerTest.  This guide will walk you through the installation process.  Please read these instructions carefully as you install CerTest.

All documentation and help for the Windows™ version of CerTest is on line.  If you are not sure how to do something once CerTest is installed on your computer, use the Help pull-down menu to receive information or instructions on the topic with which you need help.

Computer System Requirements:  CerTest (Version 1.0) requires a 486 PC with at least 4 Megabytes of RAM, DOS 3.3, MS-Windows™ 3.1 and 40 megabytes of hard drive space before installation.

Installing AFIADL CerTest 1.0 from the CD-ROM


1.  Start up MS Windows™.


2.  Exit out of all applications.  To be sure, press Ctrl-ESC to check the Task List.


3.  Insert the CerTest (Version 1.0) CD into the CD-ROM drive.


4.  From the Windows Start menu, select Run.


5.  In the Command Line box type:  D:\SETUP and then click OK to continue.

Note:  If the “D” drive is not the CD-ROM drive on your computer system, change it to the appropriate letter and then click OK to continue.


6.  A blue screen will appear with a box asking for the directory to install to.



CerTest must be loaded on to the computer’s hard drive.  It is suggested that you select the provided directory name which will be C:\Cert_ECI.


7.  The Installation Program will copy the appropriate files to your computer.


8.  When prompted, select the Create button to add the CerTest icons to the Start menu.

How to Start CerTest


1.  From the Start menu, select the CerTest icon.


2.  Click on the CerTest title screen to get to the log-on screen.


3.  Enter the following Social Security Number and password.  This will log you onto CerTest as Sir Test, the default manager. 

Social Security Number:
123-45-6789

Password:
AFIADL

4.  Site Information:  After you log-on to CerTest the first time, you will be asked to enter your Test Control Facility (TCF) information (See the sample shown below).  This information is critical for identifying the data files that you will send to AFIADL after each test session.  Therefore, the first time you log on after installing CerTest, you will be prompted to enter this information.  You will not be able to use CerTest without entering this information.  Once you have entered the TCF Data, you will not need to enter it again.  However, if your TCF information changes, you may edit the TCF data.

Note:  If a TCF data field does not apply to your base, leave the field blank.  However, you MUST fill in the TCF Zip, TCF Shred and Base fields in order to continue.  If you are using CerTest on more than one stand-alone computer, assign each computer a different number and enter that number in the Computer Number field.  This is not necessary if you are running CerTest on a Local Area Network.
	Subject
	Sample Information

	Enter Your TCF Zip:
	32403

	Enter Your TCF Shred:
	01

	Enter a Number Identifying the Computer
	01

	Enter Your DSN #:
	596-4331

	Enter Your Commercial Phone #:
	(334) 416-4331

	Enter Your E-mail Address:
	John.Doe@maxwell.af.mil

	Enter Your Organization:
	HQ AFCESA

	Enter Your Base Name:
	Tyndall AFB

	Enter the 2 Letter Abbreviation for Your State:
	FL


How to Add a Manager
The Add Manager function registers an individual as a program manager in the CerTest system.

To add a manager:
1.
Open the Manager List.

2. Select Edit (menu bar) or click on the + icon.

3.
Select Add Manager.  Test Control Facilities are allowed to have as many managers as they need to effectively execute their CerTest responsibilities.

4.
On the New Manager Information screen:

Input:

a.  Manager’s Last Name


b.  Manager's First Name

c.  Manager's Social Security Number (SSAN)

d.  Rank and Middle Initial.

5.
Select a Password.

6.
In the Change Manager’s Password dialogue box:

a)
Input New Password.

b)
Verify Password by inputting what was typed in the New Password text box.

c)
Select OK.

7.
Select Privileges.

Within the CerTest system, a manager has three types of privileges.  These are Test, File, and Personnel privileges.  The Privileges screen displays these privilege types and subdivides the responsibilities within each type into check box options.

8.
To change the default selections for a privilege, click on the desired option’s check box.

9.
When the screen reflects the desired privileges, select OK.

10.
Select OK on the New Manager Information screen.  (A system message will display informing you that the new manager you enrolled has been added.)


11.
Select OK in the system message box.

How to Delete Sir Test

Warning:  For system security, the Sir Test manager must be deleted from your system.


1.
Log into CerTest as Sir Test.


2.
Add yourself as a manager.  (See Adding a Manager)


3.
Exit CerTest.


4.
Log into CerTest as yourself (or your new manager).

5. Delete the Sir Test Manager.

How to Delete a Manager

The Delete Manager function removes a manager from the CerTest system.

To delete a manager:
1.
Open the Manager List.
2.
Highlight the manager's name for deletion.

3.
Select Edit (menu bar) or click on the scissors icon.

4.
Select Delete Manager.

5.
Select Yes in the Delete Manager(s) confirmation box.

Shortcut keys:
SHIFT + DELETE will replace steps 3 and 4.

Note:  You may not edit or delete a manager that has privileges that you do not have.

How to Change the Test Validation Code

Once a student has answered all of the questions in a test and chooses to score the test, the message shown below will appear, requiring the test control officer to enter their test validation code.  The test cannot be scored if the validation code is not entered correctly.  This feature prevents the student from scoring their test without the test control officer being present.  

The test validation code is simply your log-in password.  Any CerTest manager's log-in password will work as a test validation code.
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This feature may be disabled but the TCO validation code is required to be entered on all AFIADL final exams to maintain test security and as an extra-added safety measure just in case there’s a computer malfunction when the test is being scored.

How to Disable a Question

This is a critical feature allows test control officers to disable a test question that has been challenged as being invalid, without having to replace the entire test.  To disable a question, you must have the Disable Code for that specific question.  The question identification number and the applicable disable code will be posted to AFIADL’s Web Site quarterly (Jan, Apr, Jul, Oct) to minimize the number of times you have to visit the Web Site.

The Web Site address is http://www.maxwell.af.mil/au/afiadl/operations/certest.htm
To disable a question:

1.  Log into the CerTest Program

2.  From the File pull down menu.  Open the Test List.

3.  Highlight the desired test.

4.  Select View (menu bar).

5.  Select Test Specs.

6.  Select Disable Question.

7.  Enter the Question ID of the question you need to disable, then select OK.

The Question ID is the test number, the section number, and the question number separated by periods.  For example, the Question ID for the third question in section 5 of test 8533 is 8533.5.3.

8.  Enter the Disable Code provided to you by AFIADL, then select OK to disable the question. 

How to Download New or Revised Tests

New or revised tests will be posted to AFIADL’s Web Site quarterly (Jan, Apr, Jul, Oct) as tests are revised and new customers start using the CerTest program.  The Web Site to download new or revised tests is http://www.maxwell.af.mil/au/afiadl/operations/certest.htm 

To Copy a Test from a Diskette:

1.  Log into the CerTest Program.

Caution:  Each new or revised test must be copied into each computer that has the CerTest program loaded on it unless you are running CerTest on a Network.

2.  From the File pull-menu select the Copy From Diskette option

3.  On the Copy From screen:

· Select Test from the List Files of Type drop-down list box.

· Select the drive containing the source diskette from the Drives drop-down list box.

· Select the Directory.

· Select the source file name from the File Name list

4.  Select OK.

5.  If more than one test was copied into the selected file, you must select the tests you want to copy in the Copy Tests into CerTest list box.  Select Copy.  If a test already exists in CerTest, you will be asked if you want to replace the existing test.  You will always select “Yes” if the date is newer than the existing date on the existing test.

6.  Select OK in the Copy Complete information box.

Helpful Hint:

·If you start this process with Open Test List, CerTest will automatically select Test in the List Files of Type field, allowing you to skip this entry in step 3 above.

How to Add a Student

The add student function enrolls a new student for taking tests in the CerTest system.

To add a student to CerTest:
1.
Open the Student List.

2.
Select Edit (menu bar).

3.
Select Add Student.

4.
On the New Student Information screen:

Input:

a)
Student's Last Name

b)
Student's First Name

c)
Student's Social Security Number (SSAN)

d)
Rank and Middle Initial.

5.
Select Password.

6.
In the Change Student's Password dialogue box:

a)
Input the New Password.

b)
Verify the password by inputting what was typed in the New Password text box.

c)
Select OK.

7.
Select OK on the Student Information screen.


A system message will display informing you that the student has been added.

8.  Select OK in the system message box.

9.  The following message will then appear.  “To unlock tests for this student you must go to his/her student record.  Would you like to go to this student’s record now?”  If you select Yes, it will take you directly to the student’s record so you can unlock the applicable test.  If you choose No, see How to Lock and Unlock Tests found on the next page to unlock tests at a later date and time.

How to Lock and Unlock Tests

Locking and unlocking a test allows the manager to open a test for a student to take or close a test to prevent a student from taking or viewing it.  If a test is locked, a key is displayed to the left of that test's name on the Student Record screen.

To lock/unlock a test:
1.
Open the Student List.

2.
Highlight the name of the student whose record you want to view.

3.
Select View (menu bar).

4.
Select Student Record.

5.
Highlight the test you wish to unlock on the Student Record screen.

6.
Click on the key icon directly below the menu bar.

Helpful Hints:

You can double-click on the lock column next to a test to toggle the lock status.

You can use the L and U keys to Lock or Unlock tests instead of the key icon in the tool bar.

Additional Information:
You can lock and unlock more than one test by:

1.  Pressing the CTRL key while clicking on a test. This makes an additional selection without deleting any previous selection(s).

2.  Pressing the SHIFT key while clicking on another test will select that test and all the tests between an earlier selection and your current selection.

To exit the Student Record screen:
Press CTRL + S.

How to Bookmark a Question

When taking a test, a student may choose to mark a question and return to it later before the test is exited and scored.

To bookmark a question:

1. Click on the Bookmark check box (lower left hand corner of the computer screen).

2.  Name the bookmark or accept the name provided.


3.  Select OK.


4.  Select Next to move forward in the test or the back arrow to move backwards in the test.

To return to a bookmarked question:

1.  Select Bookmark (located on the menu bar).


2.  Select the desired bookmark.

To release a desired bookmarked question:

1.  Click on the Bookmark check box (located on the lower left corner of the screen).

Additional Information:  When you choose to Exit and Score a test, a system message appears if you have any bookmarked questions.  This message asks you if you want to exit with questions still bookmarked.

How to Move Within a Test
To move forward one question at a time within a test:


1.  Select Next (located in the top left-hand corner of computer screen)


     or..

2. Press Enter

or..


3. Select View from the menu bar.  Then Select Next Question


or..

4.  Click on the arrow button located on the horizontal scrolling bar in the lower right-hand corner of the test screen

To move forward one or more questions at a time:


1.  Drag the horizontal scrolling bar to the right.

To move backwards one question at a time within a test:


1.  Select the left arrow icon in the tool bar (located left of Next button)


     or..


2.  Select View from the menu bar and Select Previous Question


     or..


3.  Click on the left arrow located on the horizontal scrolling bar in the lower right-hand


 corner of the test screen.

To move backward one or more questions at a time:


1.  Select Bookmark from the menu bar.


2.  Select Last Viewed Question


     or..


3.  Drag the horizontal bar in the lower right-hand corner of the test screen to the left.

How to Challenge a Test Question

While taking a test, a student may find a question that he/she believes to be erroneous or invalid for some reason (i.e., typo, spelling mistake, missing graphic, ambiguous question, etc.).  The student may challenge the question by clicking on the hand icon found on the top right hand corner of the toolbar, or by selecting Challenge This Question from the Help menu.  This allows the student to type a short description of the error.  All question challenges are automatically downloaded when you collect and electronically transmit the required student data files to AFIADL.
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On the other hand, on rare occasions you may be asked to view, print, re-download, or delete the question challenges.  In this case, please use the following procedures.

To Print, Download, or Delete Question Challenges:

1.  Select File (menu bar).

2.  Select Print/Download Question Challenges.  The Print/Download Question Challenges window appears.  You may restrict the Question Challenges that you print, download or delete by 

selecting a date range and/or test number range.  If you do not select a date range or test number range, all Question Challenges in the Question Challenge database will be printed, downloaded, or deleted.

Printing Question Challenges:

1.  Select Print/Download Question Challenges from the File Menu.

2.  Enter a date range and/or test number range to restrict the number of challenges you print.

3.  Click the Print button.

4.  Click the printer icon button to send the challenges to the printer; or, use the other buttons on the toolbar to browse the challenges on screen.

Downloading Question Challenges to Disk:

You may download some or all of the Question Challenges to a text file.

1.  Select Print/Download Question Challenges from the File Menu.

2.  Enter a date range and/or test number range to restrict the number of challenges you download to the text file.

3.  Click the Download to Disk button.

4.  Select a name for the text file and a path to where you would like it to be saved, then click OK.  The default file name is CHALLENG.TXT.  If the file already exists, you will be asked if you would like to append the Question Challenges to the end of the existing file.

Deleting Question Challenges from the Database:

Once you have printed and/or downloaded the Question Challenges and reported the valid ones to the CerTest point of contact, you may wish to remove them from the database.

1.  Select Print/Download Question Challenges from the File Menu.

2.  Enter a date range and/or test number range to restrict the number of challenges you delete.

3.  Click the Delete button.

4.  You will be prompted to confirm that you wish to permanently delete the challenges from the database.

5.  Click Yes.

How to Exit and Score a Test

If the student elects to exit and score the test before he/she has answered all the questions in the test, CerTest will display a message asking you if they want to return to the Unanswered Questions.  Warning:  If the student chooses to exit the test, any unanswered questions will be scored as wrong.

Once a student has answered all of the questions in a test and chooses to exit and score the test, the message shown below will appear requiring the test control officer to enter their test validation code.  The test cannot be scored if the validation code is not entered correctly.  This feature prevents the student from scoring their test without the test control officer being present.  

“To score this test, the test control officer must input their password.  If you are ready to exit and score your test, call the test control officer over to your computer now.  Press Cancel to continue reviewing your test.”

The test validation code is the TCO’s CerTest log-in password.

To exit and score a test:

Method One:

1.  The student selects Score in the tool bar of the last test question.

2.  The student selects Yes (No will cancel Exit and Score) in Exit and Score box.

3.  The Test Control Officer Validation Code box appears.

4.  The student will call the Test Control Officer over to the computer so that the TCO can enter the Validation Code, allowing the test to be scored.

5.  The Test Summary screen appears.

6.  The student may now view their results and select Cancel when done.

or..

·Select History to see their previous scores for this test (if any).

·Select OK.

·Select Cancel.

Method Two

1.  The student presses the Enter key from the last test question.

2.  The student selects Yes in the Exit and Score box

3.  Same as Step 3 in Method One.

Method Three 

1.  The student select File from the menu bar.

2.  The student selects Exit and Score.

3.  The student selects Yes in the Exit and Score box.

4.  Same as step 3 in Method One.

Shortcut Keys:  ALT + F4 will also indicate that you want to Exit and Score the test.

NOTE:
 Students can use methods 1 and 2 only immediately after answering the last question in a test and they can use method 3 from any question in the test.  

NOTE:  If they choose to Exit and Score a Test and have left any Unanswered Questions or bookmarked questions, CerTest will ask them if they want to return to the unanswered questions or bookmarked questions.

How to View a Detail Test Record

The details of a student's individual tests are found on the Test Summary screen.

To display the details of a student’s test:

1.
Open the Student List.

2.
Highlight the student whose test results you want to view.

3.
Select View from the menu bar.

4. Select Student Record.

5.
Highlight the test that you want to view on the Student Record.

6.
Select View from the menu bar.

7.
Select Detail.


The Test Summary screen appears.

8.
  Select Cancel to exit when you are finished viewing.

How to View a Test Summary

The Test Summary screen is used to view the detail of one of the tests an individual student took.  It indicates how a student scored on the test.

The Test Summary contains:
·
The student's score


·
The passing score for the test


·
Whether or not the student passed the test


·
Number of questions presented and correct for each section of the test

Student Record
The Student Record screen displays the student's CerTest profile.

To view a Student's Record:
1.
Open the Student List.

2.
Highlight the name of the student whose record you want to view.

3.
Select View from the menu bar.

4.
Select Student Record.

5.
The Student Record screen displays.  This screen displays the student's test profile.  This profile includes:

a)
Student's Specialty

b)
What tests the student is authorized to take

c)
Each test's statistics

d)
The student's test score, the test score's date, and the number of times the student took the test

To exit the Student's Record:
Press CTRL + S.

Helpful Hints:
·
Double clicking on a student replaces steps 2 through 4.

·
Pressing the Enter key replaces steps 3 and 4.

How to Print a Student Record

The Print function allows you to print a hard copy of a Student Record.

To print a student record:

1.
Open the Student List.

2.
Double-click on the student whose record you want to view/print.  The Student Record screen displays.

3.
Select File from the menu bar.

4.
Select Print.


Report Format box displays.

5.
Click on the Display Social Security Number check box if you do not want the student's Social Security Number to appear on the printout.

6.
Select Print Full Record, Organized by Training Area to print all the posttests in the student's record, organized by Training Area.  Any Filter/Sort options will be ignored when printing using this option.


or..
Select Print Record as Currently Displayed to print only those tests that are displayed as a result of 
the current Filter/Sort options.  This print will also be limited to only the selected Training Area (if not All Training Areas).
7.
The Print Preview screen displays.


Select the printer icon from the tool bar at the top of the screen.

8.
Select Print Range. (The default is all pages.)

9.
Input number of copies. (The default is 1.)

10.
Select OK.  The Student Record screen displays.

How to Gather and Send Student Test Results to AFIADL

Each time a student takes a test, CerTest automatically stores data about that test session in its database.  This data must then be downloaded from CerTest and sent to AFIADL.  To do this, you must use the Download ECI Data feature.  Note:  If you have more than one student taking a test at your base on a given day, we suggest you wait until the end of the day to download the AFIADL data for all of the students that tested that day.

When you select the Download ECI Data feature, CerTest creates two types of data files: 

·Files with a .ECI extension.  When you download AFIADL data for one or more test sessions, data for all of the selected test sessions will be downloaded to a single .ECI file.  Each .ECI file is assigned a unique file name based on the date and time (for example, 284B5CE8.ECI).

·Files with a .00A or .00B extension.  When you download ECI data for one or more test sessions, a .00A or .00B file will be downloaded for each of the selected test sessions.  These files are assigned unique file names based on the date and time of their associated test session (for example, 278D7D21.00A).

These data files contain the following data:

· Student’s test results

· Each student’s electronic answer sheet

· Cumulative statistical data about the tests taken

· Any Question Challenges 

At the end of each testing day, you must send the applicable test data to AFIADL using the following procedures:

1.  Starting with a blank diskette, use the CerTest Download ECI Data feature in each CerTest computer to copy the test data to the diskette.  Note:  All of the CerTest data can be downloaded to the same diskette.

2.  Select Download ECI Data from the File menu.  The Download ECI Data box will appear listing all the test sessions that have not yet been downloaded.

3.  Select the test session(s) (by student, test and date) that you wish to download, then select the Download button.  You should always select all of the records shown.

4.  Select the drive and directory you wish to download to.  When the test session(s) are done downloading, a message box will appear telling you how many sessions were downloaded.

Once you have downloaded the ECI data for a test session, the session will no longer appear in the list of test sessions on the Download ECI Data window.  If you wish to download a test session again, do the following:

5.  Take the diskette to the computer where the Answer Sheet Manager and File Transfer Program (FTP) client software are installed.  (To maximize the use of your time and streamline this process, we recommend you install both of these software programs on the same computer.)

6.  Insert the diskette and run the Answer Sheet Manager Program.

7.  Select Scan for answer sheet files.

8.  Select Add answer sheet files to batch.

9.  Select Save.

10.  Insert a blank diskette and select OK.

11.  The Answer Sheet Manager will respond with a message listing the files that were copied to the diskette.  These will consist of:

· One batch file with a name like ZZZZZS.NNN where ZZZZZ is the 5 digit zip code of your base, S is your base test control office Shred number, and the NNN is a number from 001 to 999.

· One or more .ECI files (one file for each computer from which CerTest data was downloaded).

12.  Exit the Answer Sheet Manager program.

13.
 Run the FTP client software.

14.
 Copy the files from the batch file diskette (used in Steps 7 and 8) to the AFIADL FTP site shown below.  Be sure to copy all of the files that the Answer Sheet Manager Program listed in Step 8, and no other files.

· FTP


Hostname:
132.60.202.90



Username:
tcf



Password:
upload

15.  Exit the FTP client software.

Once you are done, you may delete the files on the two diskettes used in the process.  These diskettes do not need to be retained as backups.  They may then be reused the following day.

If for some reason you need to download AFIADL data for a test session that has already been downloaded previously:

1.  Select Download ECI Data from the File menu.

2.  Select View Previously Downloaded Data.  The list will now show all test sessions that have been downloaded in the past 90 days.

Note:  CerTest does not retain the AFIADL data for longer than 90 days.

3.  You may now select the test session you wish to download, and select Download.

How to Copy Student Records to or from a Diskette

Copying student records to and from a diskette is absolutely critical if the student is retaking an exam they failed previously.  To accurately collect the data that will be sent to AFIADL, the student must take the retake exam using the same computer used previously or you must copy the student’s record to a diskette and copy it into the new computer before the student takes the retake exam.  The necessary steps to accomplish this task are provided below.

To Copy a Student to Diskette:

1.
Open Student List

2.
Highlight the student(s) to copy.

3.
Select Copy To Diskette (File pull-down menu).

4.
Select Yes in the Copy Student(s) box.

5.
In the Copy Student(s) To box:

· Select the drive containing the target diskette.

· Select the Directory.

· Input the file name in the File Name test box.

6.
Select OK.

7.
Select OK in the Copy Complete information box.

Note:  Do not send this data to ECI.  Use the Download ECI Data option to download the information that ECI requires.

Helpful hint:  

You may copy more than one student record at a time by selecting multiple records.  To select a block of student records, highlight the first student in the block then press and hold the SHIFT key while clicking on the last student in the block.  To select multiple student records that are not in sequence, press and hold the CTRL key while clicking on each record you want to copy.

Additional information:

Student files have an extension of .std.  When you copy students to a diskette, a text file is also created on the diskette.  This text file has the same name as the student file, but has a .txt extension.  The text file contains a list of all students copied into the student (.std) file and may be viewed using Windows® Notepad.

You may want to copy a student record from a diskette in order to reinstall a student who has been deleted from the CerTest system or to move a student from one computer system to another.  If a student record is corrupted, the student should be deleted before the record is copied to the system from a diskette.  

If you copy a student from a diskette and the student already exists in the system, you will be given the option to merge the record on the diskette with the record on the system.  The new student record on the system will contain a history of when each test was taken, but will contain a summary of only the most recent time each test was taken.

To Copy a Student from Diskette:

1.
Select Copy From Diskette (File pull-down menu).

2.
On the Copy From screen:

· Select student from the List Files of Type drop-down list box.

· Select the drive containing the source diskette.

· Select the source file name.

3.
Select OK.

4.
If more than one student record was copied into the selected file, you must select the student record(s) you want to copy in the Copy Students Into CerTest list box.  Select copy.

5.
Select OK in the Copy Complete information box.

Helpful Hint:

·
If you start this process with Open Student List, CerTest will automatically select Student in the List Files of Type field, allowing you to skip this entry in Step 2 above.

How to Backup CerTest

Backing up the CerTest system ensures having a copy of CerTest with all tests and student records in the event that your computer crashes or that your network or hard drive becomes corrupted.  The system should be backed up at least once a week, more often if there are frequent changes in tests or student records.

To back up the CerTest system: 

1.
Select Backup CerTest System from the File menu.

2.
Select the type of CerTest Backup you wish to make:

·
Site Specific Backup - This is the recommended backup type.  This option makes a backup of all student data, current statistical data, managers, and site-specific tests and graphics.

3.
On the Backup CerTest System To screen:

Select:

·
the target drive from the Drives drop-down list box 

·
the Directory

NOTE:  You may not change the file name of the backup file:

·
Site Specific Backups must be named CTBACKUP.001

4.
Select OK.

5.
If necessary, respond to any information boxes that appear.

6.
Select OK in the Backup Complete box.

Additional Information:

To restore from the backup diskettes you create, select Restore CerTest System.

In addition to the backup file, CerTest creates a text file that contains the date of the backup, the name of the Site and Station from which the backup was made, and the CerTest version number.  For Site Specific Backups, this file is named CTBACKUP.TXT.

The Backup CerTest option does NOT backup archived statistical data.

Helpful Backup Hints:

·
If you are backing up the system onto disks, be sure to have several high-density disks ready to store the backup files.

·
If you are running CerTest on a network, you may not need to use the Backup CerTest option.  Check with your network administrator about how your network is backed up.  Networks often have a tape backup system.  If your network is frequently backed up, you should not need to use the Backup CerTest option.

How to Install the AFIADL Answer Sheet Manager Program Software

Installing Answer Sheet Manager Program 

1.  Create a temporary directory on your computer's C:\ drive (e.g., C:\TEMPECI). 

2.  Copy the file ECIZIP.EXE found in the ECI directory on the TCF Test CD-ROM into this new temporary directory. 

3.  Open this temporary directory so you can see the ECIZIP.EXE file. 

4.  Using your mouse, double-click on this file.  It begins to expand, creating additional files.  Close the window after the inflation is complete. 

5.  Look for SETUP.EXE and using your mouse, double-click on it. 

6.  The initial window will ask if it is OK to install the ASM into the C:\ECI directory.  If you are upgrading and have already installed the ASM into the ECI directory, or this is your first-time installation and there is no ECI directory, please click the Continue button.  Otherwise, if the ECI directory already exists and the ASM has not been installed here, please change the path to something else (e.g., C:\ECI2) and click the Continue button.  Try to remember the installation directory in case we need to help you one day. 

7.  For those using Windows 95, please refer to Windows Help to create a shortcut for the MERGFILE.EXE.  This will make it easier to run the program.  If you are using Windows 3.x, a program group is automatically created called Answer Sheet Manager.  MERGFILE and the Answer Sheet Manager are one and the same. In Windows 95, all shortcuts are titled according to their filenames.  In Windows 3.x, we were able to display ASM's real name: Answer Sheet Manager.  There is no difference.

8.  Double-click on the MERGEFILE shortcut in Windows 95 or the Answer Sheet Manager icon in your program group for Windows 3.x. 

9.  A TCF Data screen is displayed. Fill in all the information you know. As a minimum, you must fill in the tcf zip and shred number for this to work.  Type the zip code without a "-" and without the shred number. Notice that the shred number has its own entry field.

10.  When this is complete, click the OK button.

11.  The ASM prompts you for a disk.  If you are installing and do NOT have any student disks to scan, simply insert any formatted disk and click OK.  Otherwise, refer to the Using Answer Sheet Manager below for assistance on how to use the ASM program.

Using the Answer Sheet Manager Program
1.  Refer to Setting Up Answer Sheet Manager on the previous page if the ASM program has not been installed.

2.  You will need two diskettes to save your batch files and backup files.  One diskette should be labeled batch and the other backup.

3.  Double-click on the MERGEFILE shortcut in Windows 95 or the Answer Sheet Manager icon in your program group for Windows 3.x.

4.  Insert the first student test disk.

5.  Click on the Scan Disk for Answer Sheet Files button.  You should see at least one answer sheet file displayed in the New Files area.  If not, please call or E-mail us for assistance.

6.  Click on the Add Answer Sheet Files to Batch button.  The file(s) should move to the Batch area.  If you have other student test diskettes to batch, remove the first student test diskettes and insert the next diskette.  Click on Add Answer Sheet Files to Batch button.  The file(s) should move to the batch area.

7.  Select Save from the menu.  You will be prompted for another disk.

8.  Insert the batch disk and click on the OK button.  When the save is complete, you will return to the ASM.

9.  Select Exit from the menu.  When prompted to perform a backup, click the OK button.  You will again be prompted for another disk.

10.  Insert the backup disk and press the OK button.  When finished, the ASM will close and your computer will return to its original state.  Remove the backup disk.

11.  Please refer to Help in the menu selection for assistance if you have questions.

12.  Below are instructions on how to transfer batch files.  Remember that you must NOT transfer the raw answer sheets.  They are easily identified by their filenames.  They all begin with the letter v.  The next seven digits in the filename are the first seven numbers of the student's Social Security Number (SSN).  The file extension will correspond with the student's course number.  It will be one of these: 00A, 00B, 00C, 00D, or 00E.  Please, transfer only batch files.  The easiest way to avoid confusion is to insert the batch disk after removing the backup disk.  Put all other disks away.

How to Install the File Transfer Program (FTP) Software

WS_FTP Pro is a Windows-based application for transferring files between your PC (the local system) and a remote system. Using WS_FTP Pro, you can connect to another system from your PC, browse directories and files on both systems, and transfer files between the systems.

WS_FTP Pro provides ease of use for the beginner plus a full set of functions for the power user.  See WS_FTP features for a list of some of the available features.

WS_FTP Pro is a File Transfer Protocol (FTP) client application that complies with the Windows sockets (Winsock) standard.  WS_FTP Pro can connect to any system that has a valid Internet Address and contains an FTP server program, allowing you to transfer files between a wide variety of systems, including Windows, OS\2, and UNIX systems.

To install the FTP software, run Ws_ftp95\Install.exe and follow the prompts on the computer screen.

If you experience problems installing this software detailed procedures are available on the AFIDAL Web Site: http://www.maxwell.af.mil/au/afiadl/operations/xferguid_fr.htm
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